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we are using Adobe Pho+0ShoP ELEmMEeNn+s

The Displace Filter allow you to place alternate skins on faces, walls where no walls exist, and much
more. You can make flags wave, place flags on faces, just be creative.

To Make photos look their best
- Create amazing composites with easy-to-use tools
« Brush away wrinkles, unwanted objects, and other flaws
- Make selections in a snap so you can easily adjust specific areas of a
photo
- Easily adjust skin tones for a more natural look
- Fine-tune exposure with color curves adjustments
and the enhanced Brightness/Contrast control
To Do more with photos
- Start creating quickly, no experience necessary
- Express your ideas in customizable layouts
- Create photo books with greater ease and flexibility , ADOBE
- Entertain friends with custom slide shows and interactive web galleries g! Eﬂ%ﬁgﬂ{f?’ _
- Share with family and friends using a variety of fun options <
To Easily find and view all photos and video clips
« Instantly download photos from your camera
- Categorize photos and video clips with easy-to-use visual tags
« Group photos into convenient Albums
- Develop creations more quickly by gathering the photos you need for a
specific project in one place
- View and organize your photos quickly, even when your library grows
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® Photoshop Elements File Edit Image Enhance Layer Select Filter View Window Help
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Pattern . Mode: Normal Opacity: 100% Tolerance: 32 ./ Anti-alias .~ Contiguous  All Layers

Menu bar Contains menus for performing tasks. The menus are organized by topic.
For example, the Enhance menu contains commands for applying adjustments to an
image.

Workspace buttons Moves you between the Guided Edit, Quick Fix, and Full Edit
workspaces. These buttons change according to the current workspace.

Toolbox Holds tools for editing images.

Options bar Provides options for the tool you select.

Project Bin Displays thumbnails of opened images, and lets you easily manage them.
Palettes Help you monitor and modify images.

Palette Bin Helps you organize the palettes in your work area.

Note: To view the area behind open photos, including other open applications, uncheck
Photoshop Elements > Preferences > Fill Workspace Background. To fill the workspace with a
gray backdrop, select the Fill Workspace Background. option. Do NOT change this.



Toolbox overview

@) Navigation and
measuring tools

® k4, Move (V)
= & Zoom (2)
= ' Hand (H)
- / Eyedropper (I)

© Selection tools

m ' Rectangular
Marquee (M)

. Elliptical Marquee (M)

» 7 Lasso (L)
&2 Magnetic Lasso (L)
% Polygonal Lasso (L)
® 3% Magic Wand (W)

B %\ Quick Selection (A)
& Selection Brush (A)

-

@ Typetools

® '| " Horizontal Type (T)
|| Vertical Type (T)

=1 Horizontal Type

" Vertical Type
““Mask (T)

@® Crop tools

= 2] Crop (C)
m %7 Cookie Cutter (Q)
= [, Straighten (P)

O Retouching tools
" g Red Eye Removal (Y)

® 4~ SpotHealing
Brush (J)

& Healing Brush (J)

= X Clone Stamp (S)
&, Pattern Stamp (S)

® &/ Eraser (E)
&7 Background Eraser (E)
W7 Magic Eraser (E)
= & Blur (R)
A Sharpen (R)
¥2 Smudge (R)
® i’ Sponge (O)
\ Dodge (O)
&= Burn (O)
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@ Painting and
drawing tools
= ¢ Brush (B)
& Pencil (N)

l Impressionist
Brush (B)

o ColorReplacement (B)

" ‘0 Paint Bucket (K)
= M Gradient (G)

@ Shape tools

= B Rectangle (U)

@ Rounded
Rectangle (U)

@ Ellipse (U)

@ Folygon (U)

N\ Line (U)

W Custom Shape (U)
k- Shape Selection (U)

The ToOLbOX
TOOLS



Layers are like transparent sheets of acetate (clear plastic) that you can stack and rearrange.

About the toolbox

Use tools in the toolbox to select, edit, and view images; some tools let you paint, draw, and type.
The toolbox appears on the left side of the Full Edit and Quick Fix workspaces. In the Full Edit
workspace, you can move the toolbox by dragging the gripper bar at the top of the box. You must
select a tool in the toolbox before you can use it. Once selected, the tool is highlighted in the
toolbox, and optional settings for the tool appear in the options bar, which is located below the
shortcuts bar at the top of the workspace. Some tools in the toolbox have additional tools beneath
them. These are called nested tools. A small triangle at the lower right of the tool icon signals that
there are nested tools. When you select a tool, any additional nested tools appear in the options bar.

Note: You cannot deselect a tool once you select a tool, it remains selected until you select a different tool. For
example, if you’ve selected the Lasso tool, and you want to click your image without selecting anything, select
the Hand tool.

You can view information about any tool in the toolbox by positioning the pointer over it. The name
of the tool appears below the pointer, this is called the tool tip. You can click a link in some tool tips
to see additional information about the tool.
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Simplify a layer

New
Duplicate Layer...
it Delete Layer

Rename Layer...
Layer Style

New Fill Layer

New Adjustment Layer >

Change Layer Content

Layer Content Options...

Type

Simplify Layer
Group with Previous
Ungroup

Arrange

Merge Layers
Merge Visible
Flatten Image
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You simplify a smart object, frame layer, type layer, shape layer, solid color layer, gradient
layer, or pattern fill layer (or a layer group imported from Photoshop) by converting it
into an image layer. You need to simplify these layers before you can apply filters to them
or edit them with the painting tools. However, you can no longer use the type- and
shape-editing options on simplified layers.

1. Select a type layer, shape layer, fill layer, or a Photoshop layer group in the Layers

palette.

2. Simplify the layer or imported layer group:
o If you selected a shape layer, click Simplify in the options bar.

o Ifyou selected a type, shape, or fill layer, or a Photoshop layer group, choose

Simplify Layer from either the Layer menu or the Layers palette More menu.



The Displace filter uses an image, called a displacement | S p
map , to determine how to distort a selection. For | : RE‘-L\\\\;@&ZM\Q
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example, using a parabola-shaped displacement map,
you can create an image that appears to be printed on a
cloth held at its corners.

|

. Select an image, layer, or area.

. Choose Distort > Displace from the Filter menu.

3. To define the magnitude of the displacement, enter a value between -999 and 999 in the
Horizontal and Vertical Scale text boxes. When the horizontal and vertical scales are 100%,
the greatest displacement is 128 pixels (because middle gray produces no displacement).

4. If the displacement map is not the same size as the selection, select how you want the map
to fit the image: Stretch To Fit Resizes the map.
Tile Fills the selection by repeating the map in a pattern.

5. Select how to fill voids that are created by the filter in the image, and click OK. Wrap
Around Fills voids with content from the opposite edge of the image.
Repeat Edge Pixels Extends the colors of pixels along the image’s edge in the direction
you specify.

6. Select and open the displacement map. Photoshop Elements applies the map to the image.

N
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b= Make your Displacement Map of the image
Before you place skin on a face, you have to make
the displacement map you will use with the Displace
mmm filter: do either grayscale or color:
N
Change the colored image to grayscale by going to
the Enhance Menu > Adjust Color > Remove
m Color. Some people use the color image as we did.

Brightness/Contrast

U You may have to increase the contrast in the
m grayscale image. From the Enhance Menu >
=mm Adjust Lighting > Brightness/Contrast.
Q Increase the Contrast slider, then click OK.
or

U) On our color image, we duplicated the background
UEE |ayer and then used the Blend Mode - Overlay
n before flattening the image and saving as a .PSD



Displace Filter

Save As: HEAD_ADE_09_00302b.psd

ss = [ APE11
ame

\21 Embed Color Profile: sRGB IEC61966-2.1

| - @ @@0@0@0@0@0@0@0O0O0O0]
From the File Menu, go to Save As and use the save format as
an Adobe Photoshop (.PSD) file. Depending on the contrast in the
image, you may want to duplicate the layer and then use a blend
mode (we used Overlay on a color image) to enhance the
displacement map before flattening and saving in this step.
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» Effects
v Layers
Normal Opacity: 100%

66.67% 7.931 inches x 11.167 inches (72 ppl)



Solid Color...
Cradient...
Pattern...

Levels...

Brightness/Contrast...

Cradient Map...
Photo Filter...

Invert
Threshold...
Posterize...

Hue/Saturation
® Learn more about: Hue/Saturation
Edit: Master

Hue:

Cancel
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» Effects
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HEAD_ADE_09_00302b.png @ 66.7% (Layer 1, RGB/8)
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» Effects
v Layers

Normal Opacity: 100%




1\l View Window Help

Filter Gallery...
Correct Camera Distortion...

Adjustments
Artistic
Blur

Brush Strokes

[ )| (o
Noise
Pixelate
Render
Sketch
Stylize
Texture
Video
Other
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Liquify...

Ocean Ripple...
Pinch...

Polar Coordinates...
Ripple...

Shear...

Spherize...

Twirl...

Wave...

ZigZagqg...

Displace

Horizontal Scale 10 | OK

Cancel
Vertical Scale 10

Displacement Map:
() Stretch To Fit
Tile

Undefined Areas:
(e) Wrap Around
Repeat Edge Pixels
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=\ 8 Select Filter View Wi
Duplicate Layer...
W Delete Layer

Rename Layer...
Layer Style

New Fill Layer
New Adjustment Layer

i Croup with Previous %G

Arrange

Merge Visible
Flatten Image

This becomes a clipping group
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» Effects
v Layers

Normal
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Normal
Dissolve

Darken
r Y -1-:1
Color Burn
Linear Burn
Darker Color

Lighten

Screen

Color Dodge

Linear Dodge (Add)
Lighter Color

Overlay
Soft Light
Hard Light
Vivid Light
Linear Light
Pin Light
Hard Mix

Difference
Exclusion

Hue
Saturation
Color
Luminosity

66.67% 7.931 inches x 11.167 inches (72 ppl)
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» Effects

v Layers
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Unlike Photoshop, Photoshop Elements only applies layer masks to
adjustment layers; there is no tool or menu option for adding a layer
mask to an ordinary layer. However, there is a way to add a layer mask
using a clipping group.

Layers Palette with Clipping Group Result

To create a layer mask:
1. Open a new image and fill the background layer with a solid color.
2. Create a new Levels adjustment layer above the image layer. In the
Levels window, do not make any changes and click OK. Notice that the adjustment layer contains a
layer mask filled with white.

3. Create a third layer above the Levels adjustment layer and fill it with a contrasting color.

4. Select the top layer and press Ctrl+G to clip the layer to the layer below. You have created a
clipping group that groups the two layers together; the layer mask attached to the adjustment
layer now affects the top layer, too.

5. Paint the mask on the Levels adjustment layer:

a. Select the mask on the Levels adjustment layer.

b. Select the Brush tool and choose a large soft brush. Alternatively, you can make a selection
and fill the selection with black.

c. With the mask selected, paint on the picture with black to hide the pixels on the top layer and
show the pixels below. (The black paint will show on the mask, not the picture.)



http://www.alibony.com/graphics/def_layer_mask.html
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